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TI PLC Development Kit Overview Features
• DSP control card with Texas InstrumentsTI Designs

F28069 microcontroller (1)

TI Designs provide the foundation that you need, • AFE daughter card with Texas Instrumentsincluding methodology, testing, and design files to integrated powerline communications analogquickly evaluate and customize your system. TI front-end AFE031Designs helps you accelerate your time to market.
• For example operating frequency ranges,

see Table 1Design Resources
• Data rates from 5.592 kbps to 34.16 kbps

TINA Spice SPICE Simulator (@36 tones per symbol) for Cenelec A band
OPA2333 Product Folder and up to 289 kbps for FCC band
OPA2188 Product Folder • Transmission with OFDM and FEC

• Number of used data carriers up to 36 for
Cenelec and 72 for FCC

• Differential Phase Modulation
ASK Our Analog Experts (ROBO/DBPSK/DQPSK/D8PSK)
WebBench Calculator Tools

• Reed Solomon Encode and Decode, andTI Designs Precision Library
Repetition Code

• Convolutional Encoder and Viterbi Decoder
• Bit Interleaving for Noise Effect Reduction
• CRC5 in FCH and CRC16 in Data for Error

Detection
• Data Randomization for Uniform Power

Distribution
• Tone Mask for SFSK Co-Existence
• Adaptive Tone Mapping and Transmit Power

Control
• Automatic Gain Contreol
• Zero-Crossing Detection
• Supports G3 PHY, MAC, and Adaptation

Layer
• RS-0232 Interface for Diagnostic Port

Interface
• Serial Interface for Host Data Port Interface:

UART, SPI, Etc.
• LEDS and Test Points for Firmware and

Hardware Debug
• USB and JTAG for Custom Firmware

Download

(1) In the case of G3 FCC band, F28m35x control card and
Discrete AFE should be used.

1TIDU237–March 2014 TI G3 Power Line Communication Developer's Kit Design Guide
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com/lit/pdf/sprc123
http://www.ti.com/product/opa2333
http://www.ti.com/product/opa2188
https://infolink.sc.ti.com/g/
https://infolink.sc.ti.com/g/
https://infolink.sc.ti.com/g/
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU237


www.ti.com

An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other
important disclaimers and information.

(1) Docking board Revision E and AFE board Revision B are shown here.

Figure 1. TI PLC Development Kit

Table 1. Operating Frequency Range
CENELEC FCC ARIB

Band A B BC BCD Low High Full Low High
Frequency 35.9-90.6 98.4-121.9 98.4-137.5 98.4-146.9 145.3-314 314-478.1 145.3 - 478.1 10 - 200 200 - 450(kHz)
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0.1 PLC Development Kit Components
The development kit includes the following hardware:
• Two sets of development boards; each set contains the following:

– 1 F28069 or F28M365x MCU control card, flashed with G3 PLC Image of:
• g3_plc_f2806x_AFE031.out (for F28069)
• g3_plc_F29M35x.out (for F28M35x)

– 1 Docking Station
– 1 AFE Board

The development kit includes the following software:
• G3 PLC Binaries

– G3 PHY and Lower MAC Project Binary Image
• (g3_plc_FF2806x_AFE031.out for F28069)
• (g3_plc_F28M35x.out for F28M35x)

• G3 PLC Software Libraries for F28069
– G3 PHY Library: phy_vcu_afe031.lib
– G3 Stack (MAC [ADP]) Library: g3_stack.lib
– G3 Task Library: g3_task.lib
– G3 AFE Library: hal_afe031_f2806x.lib
– F28069 Support Libraries: csl_f2806x.lib, uart_f2806x.lib, bfm.lib

• G3 PLC Software Libraries for F28M35x
– G3 PHY Library: phy_vcu_fcc.lib
– G3 Stack (MAC/ADP) Library: g3_stack.lib
– G3 Task Library: g3_task.lib
– G3 AFE Library: half_afe031_f28m35x.lib
– F28M35x Support Libraries: csl_f28m35x_c28.lib, csl_f28m35x_m3.lib, uart_f28m35x.lib, bfm.lib

• PC Software and GUI
– Zero Configuration GUI v2.66

• Example Projects:
– G3 PHY Project: example of using PHY lib only
– G3 ADP Project: Example of using ADP Lib
– G3 Host Application Project: Example of Emulated eMeter Application on Host

The development kit includes the following documentation:
• G3 Software API Specifications

– HAL API Spec
– PHY API Spec
– MAC API Spec
– Host Message Protocol Spec

• G3 Hardware Documents
– AFE Daughter Card Schematics and Gerber Files
– Docking Board Schematics and Gerber Files
– BOM
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0.2 System Installation Requirements
To install the software package on PC to communicate with the PLC development kit, your computer must
meet the following minimum requirements:
• Microsoft Windows XP (SP2) or Windows 2000 (SP4)
• Pentium IV 1 GHz processor
• Microsoft .Net framework 3.5 SP1
• 128 MB of RAM (256 MB of RAM Recommended)
• USB 2.0 interface (if using JTAG Debug Interface)
• CD-ROM drive
• Screen resolution of 1024x768 or better
• 1MB of free space on the HDD for the applications and additional space for LOG files.

0.3 Software Installation
To install the G3 PLC software package, run the Zero Configuration installer,
"ZeroConfiguration_Setup.msi" that is included on the cd.

The G3 PLC software package includes the following:
• Software documentation and API specification (G3 PHY and G3 MAC) under "doc" directory
• Hardware documents (docking board and AFE daughter card) under "HW" directory
• software binaries under "SW" directory:

– g3_plc_F2806x_AFE031.out – This image supports G3 PHY, MAC, and ADP for F28069
– g3_plc_F28m35x.out –This image supports G3 PHY, MAC, and ADP for F28m35x

• Example projects under "SW" directory zip files
– G3 PHY example project – Demonstrates the use of PHY library API for F28069 and F28M35x
– G3 ADP example Project – Demonstrates the use of ADP library API (only for F28069)
– Host application example project – Demonstrates the use of the host message protocol to

communicate to the PLC for F28069 and F28M35x
– CM3 IPC HCT example project – Demonstrates CM3 host example to communicate to PLC on

C28x via IPC only for F28M35x
• Tools

– Zero configuration installer – This installs the Zero Configuration GUI
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1 Hardware Set-Up
Complete the following steps to set up the PLC-DK hardware
1. Ensure the system is unpowered
2. Insert the F28069 control card in to connector J1 on the docking station
3. Insert the AFE card on the docking board. Connect the connector J2 (AFE card) to connector J4

(docking station). Connect J3 (AFE card) to J10 (docking station)
4. Connect the 12-V DC power supply to the 12-V power jack (ensure the board power supply switch is

OFF)
5. Connect the power cables to the TB1 connector
6. Connect the serial cable to the serial connector on the docking station. Note that a NULL modem cable

(TX and RX cross-connected) is used between the host PC UART port and the PLC-DK. Note that, for
dock hardware Rev-C, a ribbon cable is provided for serial connection. and For hardware Rev-E, a null
modem serial cable should be used.

7. Turn on the board power-supply switch (the ON and OFF Switch)
8. Check if the LED on the F28069 control card is blinking.

1.1 G3 PLC Point-to-Point Hardware Setup
The PLC-DK can be used to demonstrate point-to-point or point-to-multipoint communication over a power
line. This is to be used with the Zero Configuration GUI or the PLC Quality Monitor GUI tools to test PHY
and MAC operations, and to send data between the two boards over the power line media (1). This setup
requires 2 PCs, and 2 null modem or USB cables.

The default setting for the Zero Configuration is to use the USB cables.

If the host PC can be configured to use two serial ports or two USB ports, then the demo setup can be
demonstrated on a single PC, using different serial ports to communicate with each PLC.

Figure 2. PLC-DK Point-to-Point Hardware Setup
(1) Note that the DSP control cards are pre-loaded with "g3_plc_F2806x_AFE031.out" and ready to be used.
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1.2 PLC-DK Default Jumper (Connector) Settings
The PLC Development Kit provided is configured with the default jumper (connector) positions. Table 2,
Table 3, Table 4, and Table 5 describe the connector/jumper name, descriptions, default positions and
other options if available.

Table 2. PLC AFE Conntector (Jumper)
AFE Connector Descriptions Default Position(Jumper)

J4 DAC and PWM selection 2-3 DAC
J6 RX filter input selection 1-2 from PGA1
J7 RX PGA1 Input Selection 1-2 from front-end
J8 RX PGA2 input selection 1-2 from RX filter
J9 ADC input selection 1-2 from PGA2 output

Table 3. PLC Dock Connector (Jumper)
PLC Dock Descriptions Default Position Options
Connector/Jumper
J1 DSP Control Card Connector
J2 SCI-A Connector
J3 F28335 Boot Options Open Open Boot from Flash

1-2 Boot from SPI-A
2-3 Boot from SCI-A

J5 ECAP Channel 2-3 1-2 ECAP1
Selection 2-3 ECAP3

J6 SCI-CCAN Bus Connector
J7 GPIO Test Pin Open 2 GPIO1

4 GPIO3
6 GPIO4

J8 Transformer Connection Close Open T1/ T2 Not Used
Close T1/ T2 Is Used

J9 External Isolated RS232 Open Open External Power NOT used for
Power RS232

Close External Power used for RS232
J10 AC Mains Close Open Mains Not Connected

Close Mains Connected
J12 ADC Input Selection 1-2 1-2 ADC-A1 (F28069)

2-3 ADC-A0 (F28335)
J13, J14, J15, J16 SPI-A / McBSP-B to 2-3 1-2 SPI – A Select (F2803x)

AFE031 Selection 2-3 McBSP B Select (F28335)
J17 AC Mains Close Open Mains Not Connected

Close Mains Connected
J18, J19, J20, J21 SPI-A/McBSP-A to PGA 1-2 1-2 SPI McBSP- A to AFE (F28069)

AFE031 Selection PGA
2-3 McBSP Other to PGAAFE

(F28335/03x)
J22 Output Capacitor Band 1-2 1-2 CENELEC/FCC

Selection 2-3 Less Than 20kHz
J23 Transformer Primary 1-3 1-3 T1 – 1:3, T2 – 1.5:1

Ratio Configuration 3-4 T1 – 1:2Selection
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Table 3. PLC Dock Connector (Jumper) (continued)
J24 Output Inductor Band 8-Jul 1-2 CENELEC B/C

Selection 3-4 Less than 20kHz
5-6 FCC
7-8 CENELEC A

J25 Transformer Secondary 4-Feb 2-4 T1 – 1:4 & 1:2, T2 – 1.5:1
Ratio Configuration
Selection

M3 AFE Daughter Card Connector
JP1 Power Supply Connector
TB1 Power Line Connector

Table 4. PLC USB/JTAG/SCI Macro
USB/JTAG/SCI Macro Descriptions Default Position Options

J1 Boot Selection Open Open Boot from Flash
Close Boot from SCI-A

J2 JTAG Connector
J3 N/A Open Connected to GPIO34
J4 USB/SCI-B Selection Close Open SCI-B Not Connected to USB

Close SCI-B Connected to USB
J5 XDS100 Reset Open Open XDS100 Held in RESET

Close XDS100 operating

Table 5. F28M35x (Concerto) Control Card Connector (Jumper)
USB/JTAG/SCI Macro Descriptions Setting Options

SW1-1/2/3/4 Boot selection Off Boot from CM3 flash then C28 flash
SW3-1 UART TX off off SCI-A from docking board

on SCI-A from USB-JTAG port
SW3-2 UART RX off off SCI-A from docking board

on SCI-A from USB-JTAG port
J16/J17/J18 C28 IO connection connect row-A and row- IO ports routed to DIMM side

B
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2 Using the Demo Application – Zero Configuration GUI (ZCG)
The Zero Configuration GUI (ZCG) is a windows application that the PLC-DK user may immediately start
performing text and file transfers, examine the current system information, display the PHY parameters,
change the PHY modulation, display the file and text transfer statistics, and display and save log
information.

Figure 3. Zero Configuration GUI (ZCG)
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2.1 Configuration
There is no software or PLC configuration needed to use the Zero Configuration GUI (ZCGUI). The only
requirement is that the USB ports (SCI-B) on the PLC are used.

The first available COMM port on the PC, which may be a USB to Serial Port or a standard COMM port,
will be used to connect to the PCL.

If no available serial ports are found on the PC, the ZCGUI will display an error, as shown in Figure 4

If the PLC is reset while connected to the ZCG, the ZCG must be restarted or reconnected using the
Serial Port Connection menu.

Figure 4.

If there is no response from the COMM port selected, the Zero Configuration GUI will display a timeout
error, shown in Figure 5, and remain active.

Figure 5.

If the PLC is connected to another COMM port you may use the use the “Serial Port Connection” drop-
down menu to connect to the desired COMM port.

If the PLC is not connected, connect the PLC to the desired port and try again. If the PLC is connected to
the correct COMM port reset the PLC. If the PLC is connected by the PLC serial ports instead of the
default USB ports this message will be displayed.

If you wish to use the PLC serial ports instead of the USB ports, the Zero Configuration GUI configuration
file must be changed. The configuration file is an XML file that has a number of configuration options that
may be changed, and some configuration options that should not be changed.

To change the default PLC port to be used, change the “DefaultSCIPort” to “SCI_A” (PLC serial port
connection) or to “SCI_B” (PLC USB port connection) in the configuration file.
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The default location for the Zero Configuration GUI configuration file can be found here:

“C:\Program Files\Texas Instruments\PLC Application Suite\ PLC_Application_Suite.exe.config”.

See Table 6, listing the configuration options that may be changed and their descriptions.

Table 6. Possible Changes for XML
XML Tag Description Default Value Range of Values
ConnectionAttempts This is the number of retries the GUI will attempt 3 1- ####

to connect, initialize, and configure the PLC
before displaying the failed initialization message
box.

DefaultG3Security This will set the default security value for G3 data Disabled Enabled
messages. DisabledSecurity G3 for data transfers is normally
enabled for G3 firmware versions greater than
1.3.1.0. This setting can override this behavior
and disable security. If the version is less than
1.3.1.0 the security is disabled even if this value
is enabled.

FileTransferPageSize This is the number of bytes transferred at a time 256 1 – Max Packet Size
during a file transfer. This does not count the
extra data sent in the data packet during a file
transfer. 24 bytes of the data packet is used for
the file transfer protocol.

CloseAllOnExit If this is set to true than all instances of the Zero FALSE True or False
Configuration GUI will close when any instance
on a PC is closed.

DefaultSCIPort This is the default SCI port to use. The data and SCI_B SCI_A
diagnostic ports must be set to the same port for SCI_Bthe file transfer

2.2 Main Screen
The ZCG consists of the main screen, where text and file transfers may be performed. The tabs in the
right panel show important information about the PLC.

The attached COMM port is displayed in the title bar, and the first available and unopened COMM port is
automatically chosen. The “Serial Port Connection” drop-down menu may be used to change the selection
to another COMM port.

From this screen you can perform text message transfers and file transfers with another PLC controlled by
the Zero Configuration GUI.

You may also change the mode by using the ‘Mode’ drop-down menu. There are two modes: Zero
Configuration and Intermediate.

The following describes the Zero Configuration mode. Any available COMM port 1-## will work with the
Zero Configuration GUI. The comm port number does not have to be less than 10.

The intermediate mode runs from a different dialog and gives the user more configuration options and
functions to perform.
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Figure 6. Main Screen

2.3 Hot Keys
There are several hot keys available. The alpha key is not case sensitive.

<Control + I>—Will close the GUI and execute the PLC Quality Monitor GUI as the intermediate tool.

<Control + R>—Will reset the file transfer statistics. The Statistics received in the Link Quality Report are
not reset. This key stroke combination will reset the statistics screen regardless of which screen
has focus in the GUI.

<Control + T>—Will toggle the expert mode menu items on and off, depending on their current state.

<Control + S>—Will send a System Information request to the PLC and update the SYstem Info panel
when received.
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2.4 System Info Panel
The PLC System information is displayed in the first tab in the right display. Right clicking on the System
Info panel will expose a context menu with one menu item, “Refresh System Information”. Clicking this will
resend a system information request to the PLC and refresh the system info panel with the updated
information.

Pressing “Ctrl + S” will perform the same function without displaying the context menu.

Any value changed will be displayed in red text.

Figure 7. System Info Panel
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2.5 PHY Parameters Panel
The PHY TX and RX parameters are displayed in the second tab, PHY Parameters.

The TX modulation may be changed using the radio boxes. Changing the modulation schemes will affect
the reliability and baud rate of the power line transmission.

Figure 8. PHY Parameters Panel
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2.6 Statistics Panel
The Statistic panel displays text and file information. Items that have changed are displayed in red.

Right clicking on the Statistics panel will expose a context menu with a single menu item, “Reset
Application Totals”. Clicking this will reset totals.

Pressing “Ctrl + R” will perform the same function, without displaying the context menu.

Figure 9. Statistics Panel
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2.7 Log Panel
The Log panel will hold about 100,000 characters, then it will refresh the display. This character refresh
prevents the panel from consuming large amounts of memory, and keeps the Log panel responsive to
new input.

Figure 10. Log Panel

The Log panel, by default, displays very little information; however, right clicking on the Log panel will
display the log context menu. Using this menu, you can enable the display of the formatted messages that
are being sent and received by the Zero Configuration GUI. See the following list of features exposed by
the context menu.

Enable Message Data Display—This will enable the log panel to display the message transfers, both
sending and receiving. Depending on the other options selected, the raw data, formatted data, or
both will be displayed. By default, this option is turned off.

Enable Logging to a File—When selected, the user will be prompted to select a file. Logged information
will be sent to this file. When enabled, all message data (both sent and received) will be saved, and
will be written to the log.

Log Full Message Data—This will display the formatted message data in the log panel. No data will be
displayed unless the “Enable Message Data Display” is enabled.

Log Condensed Data—This option will only display the message type and no actual message data. This
option reduces the amount of data logged to the screen.

Log Raw Message Data—This option will display the unformatted message data as a byte stream.

Clear Display—Selecting this will clear the log panel. This does not affect data being logged to a file.

Save to File—Selecting this will save the current contents of the log panel to a file of the user’s choosing.
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2.8 Sending Text Messages
To transfer text between two connected PLC devices using the Zero Configuration GUI, simply type your
text in the small text box and click on the “Send Message” button. Pressing ‘Enter’ while entering the text
will not send the text message but add a line to your text.

When the text is sent, the text is moved to the top of the text box and displayed by the receiving PLC

Figure 11. Sending Text Messages
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In Figure 12, the form on the left is the sender and the form on the right is the PLC message box receiving
the text. You may send text from either PLC device.

Figure 12. Message Window

If the text transfer fails, the message box shown in Figure 13 will be displayed.

Figure 13. Failed Text Message Box
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2.9 Files Transfers
The file transfer function is contained in the bottom left hand corner.

Click on the ‘Browse’ button to display the standard File Explorer dialog to choose the file you wish to
transfer. Only one file at a time may be chosen for the file transfer.

After the file is chosen, click on the ‘Transfer File’ button.

The other PLC must also be controlled by the Zero Configuration GUI.

When the transfer starts, the GUI will display a progress bar in the bottom-left corner on both Zero
Configuration GUIs. The GUI below is the receiving Zero Configuration GUI, and it displays the path and
file name where the received file is being copied. The user is not allowed to change the directory path of
the received file.

Figure 14. GUI Progress Bar
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When the file transfer is complete the message box shown in Figure 15 will be displayed on both Zero
Configuration GUIs.

Figure 15. File Transfer Complete

If the file transfer fails, one of the message boxes in Figure 16 or Figure 17 will be displayed by the
sending GUI.

Figure 16. Unable to Start File Transfer

Figure 17. Transfer Failed

The file transfer may be canceled by clicking on the 'Cancel' button on either the sending or receiving GUI.
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3 Use the Intermediate Mode
The Intermediate mode is a diagnostic tool that the user may use to provide graphical displays, system
information, PHY and MAC parameter configurations and statistics.

3.1 User Interface
The PLC quality monitor consists of the following:
• Main Menu – All operations are initiated from the main menu with toolbars, buttons, and context

menus.
• Graphical Displays

– PHY Parameters – PHY parameters configuration (see details below)
– RSSI graph – Plot is in dBuV. Note this is limited between 70 dBuV and 98 dBuv.
– SNR graph – Plot is in dB.
– Bit Error Rate Graph – Plots of PHY layer bit error rate, one line for each MCS.
– Packet Error Rate Graph – Plots of PHY layer packet error rate, one line for each MCS

• PHY Statistics – This panel provides statistics in the physical link.
• Transfer Statistics – This panel provides statistics when file transfer is in operation.
• System Information – This panel provides system version information and System/PHY/MAC

configurations

Figure 18. User Interface
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3.2 System Configuration
The system configuration provides a way to configure the PLC device (Menu -> Options -> Set System
Config).

Figure 19. G3 System Configuration Window

The following describes the configuration settings.
• Hardware Revision – Docking Board Revision ID (default: Rev. D)
• Firmware Version – Firmware Version ID
• Device Type – The current type of the device

– G3 – G3 Standard
• Device Mode –The current mode of the device.

– G3 – For host eMeter applications such as hostAPPEMU running in PC and communicate with TI
PLC at ADP layer through UART based on TI HOst Message Protocol. It does not perform network
registration and attach automatically.

– Point-to-Point – Using the end-to-end setup between the two PLC devices. This mode interfaces
with the eMeter GUI performing its functions such as PHY testing, File Transfer, Message Transfer,
etc.

– MAC Mode – For host eMeter applications such as hostAPPEMU running in PC and communicate
with TI PLC at PRIME MAC layer through UART based on TI Host Message Protocol.

– Embedded AppEmu Mode – For host eMeter application running the embedded AppEmu
• Serial Ports

– Data Port –The Data Port is the serial port the PLC device used for host and PLC communication
following "plcSUITE host message protocol". This can be either SCI-A or SCI-B on Rev C.
hardware and newer. This port is used by a host application (hostAPPEMU) to communicate with
the PLC device.
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– Diagnostic Port –The Diagnostic Port is the serial port the PLC device uses to transfer diagnostic
messages to the PLC Quality Monitor or Logger Tools. This can be either SCI-A or SCI-B on Rev
C. hardware and newer. If using IEC432/LLC, the Diagnostic port can be shared with data port if
required; however, if using IPv4, the data port and diagnostic port must be different and cannot be
shared. (Note: SCI-B shall not be selected for docking board hardware prior to Revision C.)

• Address
– Extended Address – Extended address in eight-hex bytes

• PHY Parameters
– Enable Tonemask Request
– Enable Coherent Modulation – Enables Coherent Modulation (Note:not yet supported in Release

v5.0.x.x)

The following example illustrates how to change the device type from "MAC" to "Point-to-Point":
1. Menu -> Options -> Set System COnfig
2. Pull down menu from Device Type
3. Select Point to Point
4. Click OK

Figure 20. Changing the Device Type
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3.3 Getting System Information
The Get System Info option (Menu->Options->Get System Info) retrieves the current System Information
values from the PLC-DK. These values are represented in the System Information view, and may be set
using the Set System Config (Menu->Options->Set System Config). You may also right click in the System
Info panel to display the context menu.

Figure 21. Getting System Information
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3.4 Control Set Up
The Control Setup option (Menu -> Options -> Control Set Up) allows the following.

Channel Status Update -— Select "Enable Synchronization Parameters" check box for status display in
statistic window

Link quality report updated -— Select "Enable Link Quality Report" check box for RSSI/SNR/BER/PER
display in the statistics window.

MAC statistic update –— Select "Enable MAC statistics" check box for MAC statistics display in MAC
statistic wqindow. (Note: this is not supported.)

Update period in seconds –— Enter duration between statistics updates, 3 is recommended.

Figure 22. Control Setup

NOTE: If both transmit and receive PLC LQM tool is running on the same PC, it is recommended to
use a larger update period (for example, 3 second), to avoid too much traffic between the
device and the host PC.
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3.5 Configuring PHY Parameters
The PHY parameters configuration (Menu->Options->PHY parameters) is used for configuring the PHY
transmitter (Figure 23) and receiver parameters (Figure 24).

Figure 23. Transmit PHY Parameters Figure 24. Receive PHY Parameters

The following describes the PHY TX parameters that can be configured:
• TMR Check Box – Enable tone map request

– Coherent Modulation – Enable coherent modulation (Note: This feature is not yet supported in
Release Version 5.0.x.x)

• Modulation – ROBO, DBPSK, DQPSK. (Note: This field is ignored if sweep MCS is selected)
• Level – From 0 to 32, with 32 being the maximum
• Tone Mask – Tone Mask is always enabled

– The tone masks and associated subbands are maintained in an XML file “AvailableToneMask.xml”.
Each mask octet represents 8 tones with LSB being the lowest tone number. The octets are
arranged as lowest 8 tones (tone index 0 to 7) to highest 8 tones in the frequency band. To enable
a another tone mask add it to this xml file.

– The RX and TX tone masks will always be the same.

The following describes the PHY TX parameters that can be configured for PHY Tx test mode only:
• Test Mode - When enabled, it configures the transmitter in test mode and it transmits fixed data

pattern (selected in data pattern box) for BER testing
• Sweep MCS – When enabled, test will sweep through all MCS for the packets transmitted. The order
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of MCS used is ROBO, DBPSK and DQPSK.
• Sweep PPDU Length – When enabled, test will sweep through all valid PPDU length in increasing

order for the MCS used.
• Continuous – When enabled, test will continuously transmit PPDUs as specified. When disabled, test

will transmit the “Number of PPDUs per setting” (see below) as specified and stop.
• Data Pattern – When PHY test mode is enabled, data pattern for the packet payload to be transmitted

can be selected. The following data patterns are available:
– A ramp data pattern from 0 to 255
– A fixed data byte set by octet value

The data pattern is repeated for the duration of the payload.
• PPDU Length – PPDU length in bytes. Note this field will be ignored when sweep PPDU length is

selected. It is also governed by maximum length allowed for the selected modulation scheme.
• Inter-PPDU Time – The gap time between PPDU in unit of 1 millisecond.
• Number of PPDUs per Setting – The number of PPDU per setting during MCS sweep, PPDU length

sweep or MCS/PPDU length sweep.

The following describes the PHY Rx Parameters can be configured:
• AGC – If selected, receiver performs automatic gain control. If unselected, manual gain setting is used.

Valid gain values are from 0 to 7 with step of 6dB.
• Tone Mask – Tone Mask is always enabled.

– The tone masks and associated subbands are maintained in an XML file “AvailableToneMask.xml”.
Each mask octet represents 8 tones with LSB being the lowest tone number. The octets are
arranged as lowest 8 tones (tone index 0 to 7) to highest 8 tones in the frequency band. To enable
a another tone mask add it to this xml file.

– The RX and TX tone masks will always be the same

The following describes the PHY Rx Parameters can be configured in PHY Rx Test mode only:
• Test Mode – When enabled, receiver will start comparing receive packet using the data pattern

selected and compute BER for BER testing.
• Data Pattern – When test mode is enabled, it can select data pattern used for comparison in

computing BER. A ramp data patter from 0 to 255 or a fixed data byte set by octet value. Note this
should be identical to the selection in the transmitter for valid BER result.

The following describes the PHY System Parameters:
• AGC Gain Min – Minimum AGC gain in dB
• AGC Gain Max – Maximum AGC gain in dB
• AGC Gain Step – Step size of AGC in dB
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3.6 Getting and Setting the MAC PIB
MAC PIB (G3 MAC standard Section 2.4 – Constants and PIB Attributes) can be configured as follows
(Menu->Function->Set MAC PIBs):

Figure 25. The MAC Settings Window
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MAC PIB (G3 MAC standard Section 2.4 – Constants and PIB Attributes) and ADP NIB (G3 MAC
standard Section 3.1 – Information PIB Attributes) can be retrieved as follows (Menu->Function->Get MAC
PIBs/Get ADP NIBs):

Figure 26.
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3.7 Get PHY PIB
PHY PIB can be retrieved as follows (Menu -> Function -> Get PHY PIBs):

Figure 27. Get PHY PIBs
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3.8 Testing PHY Performance
The PHY performance can be tested in a point-to-point configuration. One modem should be configured
as transmitter in test mode and the other modem as receiver in test mode (Menu->Options->PHY
Parameters). The hardware should be set up as described in Section 1.5. An example for PHY test with
ROBO, PPDU length of 70 bytes with data pattern of ramp and inter-PPDU interval of 20 ms in continuous
mode is shown.

Note: Concurrent bi-directional data transfer in PHY test mode is not currently supported.

Figure 28. Transmit PHY Parameters Figure 29. Receive PHY Parameters

By enabling the channel status and link quality report, and setting the report period (as described in
Section 2.3), the PHY performance (SNR/RSSI/PER/BER) will be displayed in the graphs and the
statistics will be displayed in the statistics panel.
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3.9 Sending and Receiving Message
The Send Message function (Menu->Function->Send Message) sends a small text message from one
device to another in point-to-point configuration. It is intended to test and verify communication between
the two systems in a point-to-point configuration.

Note that this operation would require the device mode to be “Point to Point”. Both the transmitting and
receiving device must be set to “Point to Point” following steps described in Section 2.3

Note that the connection type such as ARQ enabled, PAC enabled or security profile used for the
message send can be modified via System configuration settings using steps described in Section 2.3.

When this option is selected, you may fill in a message and press send; the other host will display the
message.

Figure 30. Intermediate Text Transfer

Note that the connection type such as ARQ enabled, PAC enabled or security profile used for the
message send can be modified via System configuration settings using steps described in Section 2.3.

3.10 Sending and Receiving File
The Send File function (Menu->Function->Send File) sends file from one device to another in a point-to-
point configuration.

Note: This operation would require both devices to be set to “Point to Point” mode.

Both the transmitting and receiving device must be set to “Point to Point”, following the steps described in
Section 2.3

Note that the connection type such as ARQ enabled, PAC enabled, or the security profile used for file
transfer can be modified via System Configuration settings using steps described in Section 2.3.

This function is not a guaranteed, error-free delivery (the file received may have dropped packets) and is a
means to push data from one board to another. The receiver will note both payload CRC and missing
packet errors, and will attempt to notify the sender of these errors.
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Figure 31. File Transfer Dialog Box

There are two modes for file transfer, stream and non-stream. The stream mode streams packets to the
receiver without waiting for the receiver to acknowledge receipt. At the end of a stream mode transfer,
missing packets will be requested by the receiving side to complete the transfer. In non-stream mode, the
receiver must ACK each packet before the sender will send the next packet.

The packet size may also be specified. This value represents the data packet size, not including protocol
headers. If an invalid size is entered, the following error will be displayed when Send is pressed.

Figure 32. Invalid Block Size Alert
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Once the file transfer begins, the Transfer Information section will reflect the transfer statistics.

Figure 33. Transfer Info

The transfer may be aborted by either the sender or receiver by pressing the Cancel button.
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3.11 Monitor Message Function
The monitor message function allows you to display formatted messages similarly to the log panel, but will
display only the filtered messages you desire.

Figure 34. Monitor Message Function
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Figure 35. Monitor Message Options

You are able to monitor as many or as few messages as you like using a check list box (this includes all
diag and the PLC host messages)

You are able to choose sent messages, received messages, or both.

The filtering is done by either the message id or the message id and message class.

The difference is when you filter by the message id, the requests and data returned are both displayed
(since the ids are the same). An example of this is shown when you select any data transfer message.
The data transfer message, the data confirm, and any data indication message will all be displayed, since
all have the same id.

If you filter by id and message class, you can choose to see only requests, or the data received. Using the
above example you can choose to see the data transfer, confirm, or indication individually. This filters
down to exact the message type you want to see.

Messages from the device are in red. Messages sent to the device are in blue.

When saving the display to a file via the context menu, the file is saved in a rich text format (*.rtf), to
maintain the color and tab formatting.

If “Enable Logging to File” is selected, the log data is saved to a file, but without the formatting.

You can display the full message details, or the condensed one line version; this is the version logged to
file if enabled.

The raw message format is not currently implemented.
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3.12 Flash Firmware
The flash firmware function (Menu->Function->Flash Firmware) downloads the new firmware image to the
DSP control card (instead of via JTAG using CCS flash programming as described in Appendix B).

Note: If this is the first time running the “Flash Firmware” function on an old hardware (RevB and older),
the procedures described in APPENDIX B – Download Flash Upgrade Binary to F28069 Using CCS
should be completed first before continuing.

Figure 36. Firmware Flash Dialog

The following steps should be used:
1. Enter the G3 application "sbin record file" and press the Begin Flash button; the flash upgrade

application will begin erasing the Flash.
For example, the "g3_plc_aes_F206x_AFE031.sbin" should be used for the G3 service node test.
You should see the "Erase in progress..." status appear in the dialog box as shown in Figure 37.

Figure 37. "Erase in progress...." Status

2. After Flash is erased, you will see the programming progress (packet by packet).
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Figure 38. Packet Progress Status

3. After programming is complete, you will see the following window and the new downloaded firmware
will boot up.

Figure 39. Firmware Flash Complete Status

4 Using the G3 Host Application
The G3_HostApplication demonstrates how to create and maintain G3 network connections and perform
eMeter tests where the basenode will send and receive data from each of the service nodes. The
application is geared towards network-level testing comprising of multiple hops, and also allows for MAC
and higher layer functionality testing such as network discovery and join, and emulate application level
traffic based testing across multiple hops.

The G3_HostApplication is controlled by command line parameters and an external program Host_CLI
which can monitor the G3_HostApplication state, connections, and start the eMeter test. The Host_CLI
(Host Command Line Interface) sends commands to the G3_HostApplication via a socket interface.

4.1 Running "G3_HostApplication"
The latest G3 binary should be flashed onto the F28069 and the hardware should be set up as described
in Section 1.5. The base-node and each service-node will be connected to a PC running the
“G3_HostAppliction.exe” . The G3_HostApplication will communicate with the PLC through the UART
using TI Host Message Protocol.

This demo includes the following procedures (see Appendix G for message sequences):
1. Base-node performs network start
2. Service-nodes perform network discovery
3. Service nodes perform attach (network join)
4. The Host_CLI can be used to command the base-node to send data packets to each service-node

transfer to service nodes emulating emeter reading traffic.
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5. Service-node echoes data packets to the base-node
6. Above steps will be repeated for all the meter emulation traffic
7. Service-nodes can detach and attach on command from the Host_CLI.
8. Service-nodes can also automatically reattach depending the parameters used with the

G3_HostApplication.
9. If a config file is used the parameters should be placed one per line.

4.2 Configuring G3_HostApplication Parameters
The application has several command line options available. The command line parameters are not case
sensitive.

Table 7. G3_HostApplication Command Line Arguments
Help Print this help
log Log file name
Resetlog=<y,n> Reset the log file if any, (default=n)
config=filename Read command line parameters from configuration file.
port=# Serial Port assignment, (p=#)
data=# Data Port (A=SCI-A, B=SCI-B),(default=SCI-B), (h=#)
diag=# Diag Port (A=SCI-A, B=SCI-B),(default=SCI-B), (h=#)
band=# Set Band Selection (0=Cenelec, 1=Cenelec/FCC, default = 0)

Set tone mask, default is Cenelec A 36
0 = Cenelec A 36
1 = Cenelec A 25
2 = Cenelec B

tonemask=# 3 = Cenelec BC
4 = Cenelec BCD
5 = FCC Low Band
6 = FCC High Band
7 = FCC Full Band
Set the modulation, default is ROBO
0 = ROBO

modulation=# 1 = BPSK
2 = QPSK
3 = 8PSK

txlevel=## TX Level (1-32)
node=<s,b> G3 Mode, s= service node, b= base node
discover=# Discovery Network Duration in seconds . Default is 5
panid=#### PAN Id in hex, base node parameter only. Default is 0x7755
security=<on, off> Enable or disable G3 data security during data transmission
auto=<on, off> Service node only, automatically reattach to base node, default

is on.
xadd=##.##.##.##.##.##.##.## The extended address in hex for the node. Default is the original

address
tuntap=[TunTap_Driver_Name] Not implemented in this version
testdetach=# Run Detach Test, #=number seconds to wait to detach after

attach
socketport=# Server port number, default is 30001. This is the socket port

used to communication with the Host_CLI
venid=#### Vendor Id, default is 123
pProdid=############ Product Id, up to 15 alpha-numeric characters
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Table 7. G3_HostApplication Command Line Arguments (continued)
psk=##.##.##.##.##.##.##.##.##.##.##.##.##.##.##.## or 16 byte hex PSK key. No leading ‘0x’ or spaces in the digits.
psk=################################ Each digit must be two chars , i.e. 1 = 01 and represents one

byte.
gmk=##.##.##.##.##.##.##.##.##.##.##.##.##.##.##.## or 16 byte hex GMK key. No leading ‘0x’ or spaces in the digits.
gmk=################################ Each digit must be two chars , i.e. 1 = 01 and represents one

byte. This is valid on the base node only
gmkindex=# GMK Key index to be used. This is valid on the base node only.

4.3 Configuring Host_CLI Parameters
The Host_CLI can be used to monitor the G3_HostApplication and to send commands to the
G3_HostApplication. Commands include performing the emeter test, detach service-node, attach service-
node. The base-node can also detach service nodes when given the extended address or can detach all
service nodes.

Below is the list of command line parameters for the Host_CLI.

Table 8. Host_CLI Command Line Arguments
Help Print this help
log=filename Log file name
resetlog=<y,n> Reset the log file if any, the default is n
config=filename Read command line parameters from configuration file.
noinit Do not initialize the PLC
ipv4 IPv4 address of the G3_HostApplication to send commands or

monitor
port=# Socket Port to communication with the G3_HostApplication
node-<s,b> Attached to service node or base node
stats=<#> Display stats from G3_HostApplication. If # is specified then they

will be repeated every # seconds. If the G3_HostApplication is
attached to a base-node then stats for all connected service
nodes will be displayed.

detach=<extendedAddress> Detach service node. The extended address is in hex
12.34.56.78.AB.BC.CD.EF. If attached to a service node no
extended address is required. If attached to a base node and no
extended address is specified all service nodes will be detached.
If attached to a base node and the extended address is specifed
only that service node will be detached.

Attach Service node only command. Will issue a command to the
attached service node to discover and attach to the base node.

exit Will cause the Host_CLI to exit after issuing commands to the
G3_HostApplication.

routereq=<####> Route Request command issued for service node ####. If the
service node is not specified the all nodes will be queried.

pathreq=<####> Path Request command issued for service node ####. If the
service node is not specified the all nodes will be queried

emeter Start the emeter testing
payload=<###> Length of payload to test, default is 20 bytes
messages=<###> Number of messages per test, default is one
retries=<#> Number of times to retry a failed messages, default is three
retrydelay=<#> Time to wait between failed messages, default is 15 seconds
intercycledlay=<#> Time in seconds between test cycles, default is 60 seconds
maxfails=<#> Number of consecutive messages failures that will halt the tests

to a node, the default is five.
testcycles=<#> Number of complete meter tests to run, the default is inifinite.
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Table 8. Host_CLI Command Line Arguments (continued)
destinations=<##.##.##.##.##.##.##.##> List of destination addresses to send messages to. The default
destinations=<####,####,####> is all service nodes. This will allow the user to specify which

service nodes to include in the test. This is not implemented in
this release.

stopmeter Stop the e-meter test.

4.4 Example of "Host Application Emulation" Testing for Linear Chain
To start a 4-hop, linear, chain network testing using hostAppEmu, it is recommended to adopt the
following steps:
1. Set up the 4-hop network as shown in the following.

Figure 40. 4-Hop Network

To ensure the multi-hop nature in the connectivity, it is recommended to test the setup with PLC link
quality monitor. While using the link quality monitor, it should be the case that a node is able to talk to
its immediate parent and child but not to any other node. For e.g. Service Node 2 should be able to
perform message/ file transfer with Service Node 3 and Service Node 1, but not to the Base Node and
Service Node 4.

2. Start the PAN coordinator. The following window shows the example of starting G3_HostApplication for
a PAN coordinator, connecting through COM port 8, SCI-B:
>g3_hostapplication port=8 host=1 diag=1 node=b socketport=30001
xadd=xadd=FF.FF.FF.FF.FF.FF.FF.01
logfile=basenode.log resetlog

If a config file is used the parameters would look like this
>g3_hostapplication config=basenode.txt

The contents of the basenode.txt are:
host=1
diag=1
port=8
logfile=c:\testparameters\basenode.log
resetlog
socketport=30001
node=b
xadd=FF.FF.FF.FF.FF.FF.FF.01

The socketport is the socket port address that will be used by the Host_CLI to communication to the
G3_HostApplication.

3. Start a SN. When starting multiple Service Nodes you may set the service node long addresses using
the –L option or let the node randomly choose one randomly. While assigning long addresses, we
need to ensure that they are different for each service node. The following window shows the example
of starting G3_HostApplication for a SN, connecting through COM port 9, SCI-B:
>g3_hostapplication port=9 host=1 diag=1 node=s xadd= FF.FF.FF.FF.FF.FF.FF.04 socketport=30004
logfile=c:\testparameters\servicenode-30004.log resetlog auto=off

If a config file is used the parameters are:
>g3_hostapplication config=servicenode.txt

The contents of the configuration file are:
auto=off
host=1
diag=1
logfile=c:\testparameters\servicenode-30004.log
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resetlog
socketport=30004
node=s
xadd=FF.FF.FF.FF.FF.FF.FF.04

The socketport is the socket port address that will be used by the Host_CLI to communication to the
G3_HostApplication. If the service node and base node G3_HostApplications are running on the same
PC the socketport addresses must be different or the second exe will abort. Two processes on the
same PC cannot create servers listening on the same port for connections.

4. Once the base node and service nodes are started the Host_CLI may be used to issue commands.
Using Host_CLI instance with the following command line will continuously monitor the base node or
service nodes activity every 10 seconds.
>Host_CLI ipv4=192.168.1.5 port=30001 logfile=c:\TestParameters\Monitor-
Basenode.log resetlog stats=10

Using a config file:
>Host_CLI config=monitor.txt

The configuration file contains:
ipv4=192.168.1.5
port=30001
logfile=Monitor-Basenode.log
resetlog
stats=10

The following is a configuration file used to start the emeter test.
>Host_CLI config=emeter.txt

The configuration file contains:
socketport=30001
logfile=emeter.log
resetlog
emeter
payload=20
messages=10
retries=3
intermeterdelay=30
maxfails=5
testcycles=10
exit

Up to four different service nodes can be started and run the G3_HostApplication simultaneously with
the same PAN coordinator node. Please remember to set the long addresses to be different before
start the application.
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Figure 41 is the sample output of a Host_CLI monitoring the base node during an emeter test:

Figure 41. Sample Output for Base Node Monitoring
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Figure 42 is the output from a service node during the emeter test:

Figure 42. eMeter Service Node Output
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4.5 "HostAppEmu" Testing with other Multi-Node Topologies
The hostappemu application can be used for testing other multi-node and/or multi-hop topologies. The
hostappemu application has been used for testing the network discovery, join and leave, and e-meter data
transfer testing for the following two network topologies (as well).

Figure 43. Single-Hop Network

Figure 44. Hybrid Network

The procedure to verify the network topology should be performed in a similar fashion as described in the
example by using PLC link quality monitor. Also, other procedures such as the configuration of the
hostappemu for each use case are similar to the one shown in example.
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5 System Troubleshoot

5.1 Troubleshoot fore USB to Serial Dongle Communications
When the USB to serial dongle is plugged into the PC, the enumerated COM port can be found from
system properties -> Hardware -> Device Manager as follows:

Figure 46. Device Manager

Figure 45. System Properties Window
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Note that the enumerated COM port may be changed. Change the com port assignment by selecting the
corresponding serial port, right click and click on “properties”. Then select the “features” panel and the a
COM port can changed

Figure 47. MosChip Device Properties

Note that it is recommended to power off the device prior to unplugging the USB serial dongle from the
PC.

5.2 Troubleshoot for Zero Configuration GUI Tool to Device Communications
• To check that the ZCG tool is communicating to the device, check that it can read system information

following steps in Section 2.4.
• If USB serial converter is being used, check that the correct COM port has been selected. (Note that

the COM port may not be enumerated to the same port number when its unplugged an re-plugged or a
new USB port is being used.)

If ZCG tool has previously been communicating to the device and it was kept opened while device has
been reset or power cycled, it is recommended to close the ZCG tool and re-opened.

5.3 Troubleshoot for Building Example Projects
• • When importing example projects, pls check that the cgtool version provided in

TI_PLC_G3_Demo\ccs_setup\cgtools is installed
• • When building example projects where DSP BIOS is used, please check that the bios platform files

provided in TI_PLC_G3_Demo\ccs_setup\dspbios is installed.

46 TI G3 Power Line Communication Developer's Kit Design Guide TIDU237–March 2014
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU237


www.ti.com Appendices

6 Appendices

6.1 APPENDIX A – Code Composer Studio Installation and Setup
1. Install Code Composer Studio (CCS)
2. Connect USB cable to USB connector on the docking station.
3. Launch CCS. If CCS is installed, XDS100 emulation is installed and CCS is to configure to use

XDS100 emulator
4. Connect to target and CCS is ready to be used.
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6.2 APPENDIX B – Download Flash Upgrade Binary to F28069 Using CCS
If the PLC device does not have the firmware upgrade binary image pre-flashed in the hardware device,
we can use the CCS to flash the firmware upgrade image. Refer to the following link on instructions in
programming flash.

http://focus.ti.com/lit/an/spraal3/spraal3.pdf

The On-Chip Flash Programmer settings are as follows (uncheck the sector B, C, E, F, G and H): The
image “flash_upgrade.out” should be downloaded. Once this is complete, the eMeter GUI tool “Flash
Firmware” function described in Section 4.11 can be used.

Figure 48. Download Flash Upgrade Binary
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6.3 APPENDIX C – Download PLC Binary to F28069 Using CCS
If the PLC binary is to be flashed via CCS, the following steps should be used. The On-Chip Flash
Programmer settings are as follows (uncheck the sector B, C, D):

Figure 49. Download PLC Binary
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6.4 APPENDIX D - PLC-DK Hardware Resource Usages

Table 9. PLC-DK GPIO Pins Configurations
GPIO PIN Connected to Pull Up G3 Build Usage
GPIO00 PWM_1A Enabled Transmit
GPIO01 TP Enabled
GPIO02 PWM_2A Enabled Transmit
GPIO03
GPIO04 TP Disabled XINT1, HALT
GPIO05 Disabled
GPIO06 TP Enabled XINT2, TFLAG
GPIO07 DAC Disabled DAC
GPIO08 LED_AFE3 Enabled Received packet indicator
GPIO09 ZeroCross 1 Enabled Zero crossing capture
GPIO10 Disabled
GPIO11 ZeroCross 2 Enabled Zero crossing capture
GPIO12 AFE Shutdown Enabled AFE031 Shutdown
GPIO13 Disabled
GPIO14 SCI (SCITXDB) Enabled UART host port
GPIO15 SCI (SCIRXDB) Enabled UART host port
GPIO16 SPI (SPISIMOA) Enabled PGA (option)
GPIO17 SPI (SPISOMIA) Enabled PGA (option)
GPIO18 SPI (SPICLK) Enabled PGA (option)
GPIO19 SPI (SPISTEA) Enabled PGA (option)
GPIO20 McBSP (MDXA) Enabled F28069 AFE031 connection
GPIO21 McBSP (MDRA) Enabled F28069 AFE031 connection
GPIO22 McBSP (MCLKXA) Enabled F28069 AFE031 connection
GPIO23 McBSP (MFSXA) Enabled F28069 AFE031 connection
GPIO24 Enabled
GPIO25 Enabled
GPIO26 Enabled
GPIO27 Enabled
GPIO28 SCI (SCIRXDA) Enabled UART diagnostic port
GPIO29 SCI (SCITXDA) Enabled UART diagnostic port
GPIO30 CAN RX Enabled CAN Bus Rx Port
GPIO31 CAN TX Enabled CAN Bus Tx Port
GPIO32 (I2C) SDAA Enabled EEPROM
GPIO33 (I2C) SCLA Enabled EEPROM
GPIO34 LED3 Enabled System heart beat (toggle at 1

sec rate)
GPIO35 Enabled
GPIO36 Enabled
GPIO37 Enabled
GPIO38 Enabled
GPIO39 Enabled
GPIO40 Enabled
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Table 10. PLC F28M35x (Concerto) GPIO Pins Configurations
F28M35X Signal Name Interface Usage
PA0_GPIO0 EPWM PLC TX signal
PA2_GPIO2 EPWM PLC TX signal
PD4_GPIO20 SPI(DMA) DAC/Control
PD5_GPIO21 SPI(DMA) DAC/Control
PD6_GPIO22 SPI(DMA) DAC/Control
PD7_GPIO23 SPI(DMA) DAC/Control
PB1_GPIO09 ECAP ZeroCrossing
PE4_GPIO28 SCIA Comm
PE5_GPIO29 SCIA Comm
ADC1_B0 ADC PLC RX signal
PA7_GPIO7 GPIO DAC Control
PB4_GPIO12 GPIO SD Control
C28_GPIO6/PA6_GPIO6 GPIO INT Control
C28_GPIO32/PF0_GPIO32 I2C EEPROM
C28_GPIO33/PF1_GPIO33 I2C EEPROM

Table 11. PLC-DK Peripherals and Interrupts Usage
Peripherals PRIME Build Usage Interrupt
32-bit CPU Timers
Timer 0 1. During packet transmission PIE 1.7

- Trigger Tx DMA to ePWM/HRPWM @
500 kHz
2. CSMA
- Track PRIME frame structure

Timer 1 Absolute timer (PRIME PHY Time Stamp)
Timer 2 DSP-BIOS Systick INT14
Watchdog Timer

TBD (Reset)
ADC

Rx ADC samples @ 250 kHz

McBSP
McBSPA AFE031 inteface (SPI mode)
SCI
SCIA Diagnostic port PIE 9.1 - Rx

PIE 9.2 - Tx
SCIB Host port PIE 9.3 - Rx

PIE 9.4 - Tx
I2C

Interface to EEPROM
Ecap
eCAP3 Zero crossing measure
eCAP4 Zero crossing measure
DMA
Channel 1 ADC PIE 7.1
Channel 2 DAC (McBSPA) PIE 7.2
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Table 12. PLC-DK Flash Configurations and Usage
Sectors Size (words) G3 Build Usage
A 32K Code Start Image
B 32K
C 32K
D 32K
E 32K G3 Image
F 32K
G 32K
H 32K firmware upgrade image
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6.5 APPENDIX E – PHY Example Project for F28069
The PHY examples demonstrate the calling of PHY library API when hardware is setup with 2 devices
connected via power line. One device will send one packet and wait for one receive packet and then
transmit another packet. This alternates between Tx and Rx. The packet is of size of 73 bytes with a
repeating ramp data pattern using the followings:

Modulation: DBPSK

Tonemask: Enabled

PPDU payload length: 73 bytes (40 symbols):
(a) Unzip ti_g3_phy_example.zip
(b) Start CCS4 and create new workspace
(c) In CCS4, import G3 phy test project into workspace (Menu Project->Import Existing CCS/CCE Eclipse

Project)
(d) In CCS4, Build project (Menu Project->Project->Build Project)
(e) In CCS4, launch debugger for the selected target configuration (Release_F2806x_AFE031)
(f) In CCS4 debugger, connect target (Menu->Target->Connect target)
(g) In CCS4, Load test_tx_rx_f2806x.out (Menu->Target->Load Program)
(h) In CCS4, Reset, Run (Menu->Target->->Run) and LED flashes.
(i) Load the same code to the second board.
(j) Connect the two boards via power line cables. Both boards should be alternating between Rx and Tx

and the LEDs should be blinking.

Source File Description:
• Test Bench

– Project File: .cdtbuild, .cdtproject, .project, .ccsproject
– Test bench: test_tx_rx.c demonstrates alternating G3 PHY tx and PHY rx using provided PHY

library
– OS files: test_tx_rx_f2806x.tcf (DSP BIOS version 5.41.10.36 or above)
– Linker command files: G3_BIOS_flash_F2806x.cmd, F2806x_Headers_BIOS.cmd,

test_tx_rx_f2806xcfg.cmd (BIOS generated)
– Test example for flash

• Header Files
– PHY common: phy.h
– PHY Tx: phy_tx.h
– PHY Rx: phy_rx.h
– HAL: hal_afe.h
– Chip support library header files

• Libraries
– PHY lib: phy_vcu_afe031.lib
– HAL lib: hal_afe031_f2806x.lib
– Chip Support lib: csl_f2806x.lib
– HRPWM Calibration lib: SFO_TI_Build_V6b_FPU.lib

PHY Library Demonstration
• The PHY Library example project demonstrates packet transmission and reception at the physical

layer in a TDD fashion.
• Flash 2 F28069 boards with PHY library example executable.
• Connect via powerline
• Sequence of Operation
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– Board A sends a packet
– Board B receives packet and sends a packet back to board a
– This repeats
– LED on DSP control card blinks if packet transmission and reception is ongoing.

Hardware Resource Usage
The PHY library uses the following hardware resources:
• DMA Channels

– Channel 1 – Receive ADC Input
– Channel 2 – Transmit DAC (McBSPA) output

• CPU Timers
– Timer 0 – G3 PHY TX sampling timer
– Timer 1 – G3 PHY System timer 20-bits in 10ηs increments
– Timer 2 – G3 BIOS timer

• GPIO
– GPIO 12 – AFE031 shutdown
– GPIO 7 – DAC
– GPIO 20/21/22/23 – McBSPA

PHY Library Test Bench Steps
• Hardware initialization (F28069 specific)
• Flash configuration
• ISR Installation (done through BIOS)

– DMA channel 1 (PHY_rx_dma_bios_isr)
– DMA channel 2 (PHY_tx_dma_bios_isr)

• AFE initialization
– HAL_afeTxInit
– HAL_afeRxInit

• PHY library initialization
– PHY_txInit
– PHY_rxInit

• Generate packet for transmission
• Start PHY Rx to listen to line

– PHY_rxStart (0xFFFF, cb_ppdu)

NOTE:
• Callback for PHY_rxStart - cb_ppdu
• If status is successful, process RX PPDU if needed. In this example

– Start a TX packet
– Toggle LED

• Install callback for RX bit processing start
– Post SWI to start RX bit processing in the callback

• Install callback for TX bit processing start
– Post semaphore to start TX bit processing in the callback

• Start packet transmission
– PHY_txPreparePpdu(&PHY_tx_ppdu_s, cb_tx);
– PHY_txPpdu(&PHY_tx_ppdu_s, cb_tx);
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NOTE:
• Callback for PHY_txPpdu - cb_tx
• LET toggling in this example.

• Enable system interrupt

ISR Descriptions
• DMA Channel ISR – Incoming ADC samples ready for process at symbol rate
interrupt voide PHY_rx_dintch1_isr(void)
{
/* Call HAL AFE function for RX DMA handling */
HAL_afeRxDmaCh1IntFunc();

/* post RX SWI */
SWI_post(&SWI_PHY_RX);
}

• DMA 2 Channel ISR – Outgoing PWM completed at symbol rate
interrupt void PHY_tx_dintch2_isr(void)
{

/* Call HAL AFE API for TX DMA handling */
HAL_afeTxDmaCh2IntFunc();

/* Post TX SWI */
SWI_post(&PHY_TX_SWI);

}

Tx SWI
• PHY_tx_swi_proc() – Calls PHY API for TX symbol processing (PHY_txSmRun(1)).

Tx Thread
• PHY_tx_thread() – Calls PHY API for TX bit processing when TX semaphore is available

(PHY_txSmRun(0)).

Rx SWIs
• PHY_RX_SWI() – Wait for DMA channel 1 ready (incoming ADC samples ready)

– Perform PHY Rx symbol processing
• PHY_rxSmRun(PHY_RX_PROC_SYMB

• PHY_RX2_SWI() – Starts RX bit processing
– PHY_rxSmRun(PHY_RX_PROC_BIT)
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6.6 APPENDIX F – PHY Example Project for F28M35x
The PHY examples demonstrate the calling of PHY library API when hardware is setup with 2 devices
connected via power line. One device will send one packet and wait for one receive packet and then
transmit another packet. This alternates between Tx and Rx. The packet is of size of 73 bytes with a
repeating ramp data pattern using the followings:

Modulation: DBPSK

Tonemask: Enabled

PPDU payload length: 73 bytes (40 symbols)
1. Unzip ti_g3_phy_example.zip
2. Start CCS4 and create new workspace
3. In CCS4, import G3 phy test project into workspace (Menu Project -> Import Existing CCS/CCe Eclipse

Project)
4. In CCS4, Build project (Menu Project -> Project -> Build Project)
5. In CCS4, launch debugger for the selected target configuration (Debug_f28M35x)
6. In CCS4 debugger, connect target (Menu -> Target -> Connect target)
7. In CCS4, Load test_tx_rx_f28m35x.out (Menu -> Target -> -> Load Program)
8. In CCS4, Reset, Run (Menu -> Target -> Run) and LED flashes.
9. Load the same code to the second board.
10. Connect the two boards via power line cables. Both boards should be alternating between Rx and Tx

and the LEDs should be blinking.

Source File Description
• Test Bench

– Project file: .cdtbuild, .cdtproject, .project, .ccsproject
– Test bench: test_tx_rx.c demonstrates alternating G3 PHY Tx and PHY rx using provided PHY

library
– OS files: test_tx_rx_f28m35x.tcf (DSP BIOS version 5.41.10.36 or above)
– Linker command files: G3_BIOS_flash_F28M35x.cmd, F28m35x_Headers_BIOS.cmd,

test_tx_rx_f28m35xcfg.cmd (BIOS generated)
– Test example for flash

• Header Files
– PHY common: phy.h
– PHY Tx: phy_tx.h
– PHY Rx: phy_rx.h
– HAL: hal_afe.h
– Chip support library header files

• Libraries
– PHY lib: phy_vcu_fcc.lib
– HAL lib: hal_afe_f28m35x.lib
– Chip Support lib: csl_f28m35x_m3.lib
– HRPWM Calibration lib: SFO_TI_Build_V6b_FPU.lib

PHY Library Demonstration
• The PHY library example project demonstrates packet transmission and reception at the physical layer

in a TDD fashion.
• Flash 2 F28M35x boards with PHY library example executable.
• Connect via powerline
• Sequence of Operation
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– Board A sends a packet
– Board B receives packet and sends a packet back to board a
– This repeats
– LED on DSP control card blinks if packet transmission and reception is ongoing.

Hardware Resource Usage
The PHY library uses the following hardware resources:
• DMA Channels

– Channel 1 – Receive ADC input
– Channel 2 – Transmit PWM_1A output
– Channel 3 – Transmit PWM_2A output

• CPU Timers
– Timer 0 – G3 PHY TX sampling timer
– Timer 1 – G3 PHY system timer 20-bits in 10 ηs-increments
– Timer 2 – G3 BIOS timer

• GPIO
– DPIO 00 – PWM_1A
– GPIO 02 – PWM_2A
– GPIO 12 – OPA Enable

PHY Library Test Bench Steps
• Hardware initialization (F28M35x Specific)
• Flash Configuration
• ISR Installation (done through BIOS)

– DMA Channel 1 (PHY_rx_dma_bios_isr)
– DMA channel 2 (PHY_tx_dma_bios_isr)

• AFE Initialization
– HAL_afeTxInit
– HAL_afeRXInit

• PHY library initialization
– PHY_txInit
– PHY_rxInit

• Generate packet for transmission
• Start PHY Rx to listen to line

– PHY_rxStart (oxFFFF, cb_ppdu)

NOTE:
• Callback for PHY_rxStart – cb_ppdu
• If status is success, process RX PPDU as needed. In this example

– Start a TX packet
– Toggle LED

• Install callback for RX bit processing start
– Post SWI to start RX bit processing in the callback

• Install callback for TX bit processing start
– Post semaphore to start TX bit processing in the callback

• Start packet transmission
– PHY_txPreparePpdu(&PHY_tx_ppdu_s, cb_tx);
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– PHY_tx_Ppdu(&PHY_tx_ppdu_s, cb_tx);

NOTE:
• Callback for PHY_txPpdu - cb_tx
• LET toggling in this example.

• Enable system interrupt

ISR Descriptions
• DMA Channel ISR – Incoming ADC samples ready for process at symbol rate
interrupt void PHY_rx dintch1_isr(void)
{
/* Call HAL AFE function for RX DMA handling */
HAL_afeRxDmaCh1IntFunc();

/* post RX SWI */
SWI_post(&SWI_PHY_RX);
}

• DMA 2 Channel ISR – Outoing PWM completed at symbol rate
interrupt void PHY_tx_dintch2_isr(void)
{
/* Call HAL AFE API for TX DMA handling */
HAL_afeTxDmaCh2IntFunc();

/* Post TX SWI */
SWI_post(&PHY_TX_SWI);
}

Tx SWI
• PHY_tx_swi_proc() – Calls PHY API for TX symbol processing (PHY_txSmRun(1)).

Tx Thread
• PHY_tx_thread() – Calls PHY API for TX bit processing when TX semaphore is available

(PHY_txSmRun(0)).

Rx SWIs
• PHY_RX_SWI() – Wait for DMA channel 1 ready (incoming ADC samples ready)

– Perform PHY Rx symbol processing
• PHY_rxSmRun(PHY_RX_PROC_SYMB)

• PHY_RX2_SWI() – Starts RX bit processing
– PHY_rxSmRun(PHY_RX_PROC_BIT)

58 TI G3 Power Line Communication Developer's Kit Design Guide TIDU237–March 2014
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU237


www.ti.com Appendices

6.7 APPENDIX G – G3 ADP Example Project
The ADP example demonstrates the calling of ADP library API when hardware is setup with a service
node and G3 DC connected via power line. The device first attaches to the DC and when it is done it waits
for data transfer from DC. Once the device receives a packet from DC, it sends the packet back to the
DC.

Source File Description
• Test Bench

– Project file: .cdtbuild, .cdtproject, .project, .ccsproject
– Test bench: appemu_task.c/appemu_main.c/g3_main.c: demonstrates echoing back DC data using

provided ADP library
• Header Files

– HAL: hal_afe.h
– PHY: phy.h, phy_rx.h, phy_rx_swi.h, phy_tx.h, phy_tx_swi.h, g3_phy.h

• Libraries
– G3 PHY lib: phy_vcu_afe031.lib
– G3 MAC/ADP lib: g3_stack.lib
– G3 Tas lib: g3_task.lib

g3_main.c
• Initalize hardware and software configuration
• Set device mode to SYS_CFG_DEVICE_MODE_G3_APPEMU with Auto Mode

appemu_main.c
• AppEMU_Init()

– AppEmu Timer initialization
• APPEMU_initTimer()

– Hook up ADP function
• ADP_RX_packet_start()
• ADP_alarmEvent_register()

– Start Network Discovery
• AppEMUL_startIdleTimer()

• APPEMU_procMsg()
– APPEMU_proc_ADP_DISCOVER()
– APPEMU_proc_ADP_ATTACH()
– APPEMU_proc_ADP_Detach_Indicate()
– APPEMU_proc_ADPDETACH()
– APPEMU_proc_ADP_Data_Indicate()
– APPEMU_proc_ADP_Data_Confirm()
– APPEMU_proc_Idle_Timeout()
– APPEMU_procAttachWaitTimeout()
– APPEMU_procDiscoveryStartTimeout()

appemu_task.c
• MBX_pend()

– If there is received message, call APPEMU_procMsg()

appemu_adp_msg.c
• This includes all the ADP API call routines.
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r e p ly  t o  h o s t  m e s s a g e

r e p ly  t o  P LC  m e s s a g e

r e p ly  t o  h o s t  m e s s a g e

r e p ly  t o  P LC  m e s s a g e

r e p ly  t o  h o s t  m e s s a g e

r e p ly  t o  P LC  m e s s a g e

r e p ly  t o  h o s t  m e s s a g e

r e p ly  t o  P LC  m e s s a g e

r e p ly  t o  h o s t  m e s s a g e

r e p ly  t o  P LC  m e s s a g e

P A N  D is cover y  (if P A N  ID  not  k now n )

D A TA _XF E R .r eq

r e p ly  t o  h o s t  m e s s a g e

M A C  D A TA
D A TA_XF E R . ind ica t ion

r e p ly  t o  P LC  m e s s a g e

P A N  D is cover y  ( if P A N  ID  not  k now n )
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6.8 APPENDIX H– G3 Host Application Example Project
The Host Example Project is the host based eMeter Application Emulator. It is written as an external host
application that communicates to the PLC device via Host Messages over the serial port.

G3 Host Application is a Windows console application. The project is a Visual Studio 2010 solution.
1. Unzip TI_G3_HOSTAPP_EXAMPLE.zip
2. From Visual Studio 2010, open the HostApplications.sln Solution file.
3. Rebuild the project (Build->Rebuild Solution)
4. Once the project has built, the G3 Host Application executable (G3_HostApplication.exe) may be run.
5. Reference the section above detailing the command line options and operation.

The following shows an example of Host Message Exchange sequence for network start/join and data
transfer:

Figure 50. Host Message Exchange Sequence
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H o s t
P L C  

M o d e m

A T T A C H.r e q u e st ( 0x 1 0 )

A T T A C H.co n fir m  (0 x1 0 )

S H U T _D O W N .r e q u e st (0 x 0 5)

S H U T_ D O W N.r e p ly ( 0 x0 5 )

L O A D _ S Y S T E M_ C O N F IG .r e q u e st 

(M sg  T yp e : 0 x0 C , C o n fig _ T yp e : 0 x 0 0 0 1)

L O A D _ S Y S T E M _ C O N F IG.r e p ly ( 0 x0 C )

D A T A_ T R A N S F E R.r e q u e st ( 0 x0 0 )

D A T A _ T R A N S F E R.co n fir m  ( 0x 0 0 )

D A T A _ T R A N S F E R.in d ica tio n  ( 0 x0 0 )

.

.

.

L O A D _ S Y S T E M _ C O N F IG.r e q u e st 

( M sg  T yp e : 0 x0 C , C o n fig _ T yp e : 0 x0 0 0 3 )

L O A D _ S Y S T E M _ C O N F IG.r e p ly ( 0 x0 C )

C o n fig u r e  h o st/d ia g  p o r ts to  S C I- A

C o n fig u r e  d e vice  m o d e ( =n o r m a l m o d e )

/A u to  m o d e( = 0 )

D e la y  2  s e c o n d s  a f t e r g e t t in g  re p ly

N e tw o r k D isco ve r  ( A ctive  S ca n )

S o ft r e se t

L O A D _ S Y S T E M _C O N F IG .r e q u e st 

( M sg  T yp e: 0 x 0 C, C o n fig _ T yp e : 0 x0 0 0 8 )

L O A D _ S Y S T E M _ C O N F IG .r e p ly (0 x 0C )

C o n fig u r e  G3  lo n g  a d d r e ss

S E T _ IN F O.r e q u e st 

(M sg  T yp e : 0 x0 4 , IN F O _ T yp e: 0 x0 0 0 2 )

S E T_ IN F O .r e p ly (0 x 0 4)

S E T _ IN F O.r e q u e st 

(M sg  T yp e : 0 x0 4 , IN F O _ T yp e: 0 x0 0 0 3 )

S E T_ IN F O .r e p ly (0 x 0 4)

S e t G 3  P H Y  T X  P a r a m e te r s ( o p tio n a l)

S e t G 3  P H Y  R X  P a r a m e te r s (o p tio n a l )

D IS C O V E R.r e q u e st 

(M sg  T yp e : 0 x1 2 , D isco ve r  T yp e : 0 x0 0 )

D IS C O V E R .co n fir m  (0 x 1 2 )

A tta ch  to  a  sp e cif ic  P A N  ID  

L _ S D U  d a ta  (in c lu d in g  IP v 6  h e a d e r/a d d r e ss)
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6.9 APPENDIX I – Host Message Exchange Example
We are providing a simple host interface between PLC modem and host processor. As a reference, host
message exchange example is given below, describing how the host processor can communicate to PLC
modem to initialize the network connection.

Figure 51. G3 Service Node (Normal Mode) with Non-Automatic Flag)
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H o s t
P L C  

M o d e m

S H U T_ D O W N .r e q u e st (0 x0 5 )

S H U T _D O W N .r e p ly ( 0 x0 5 )

L O A D _ S Y S T E M _ C O N F IG .r e q u e st 

(M sg  T yp e : 0 x0 C , C o n fig _ T yp e: 0 x 0 0 0 1)

L O A D _ S Y S T E M _ C O N F IG.r e p ly ( 0 x0 C )

D A T A_ T R A N S F E R .in d ica tio n  (0 x 0 0 )

L O A D _ S Y S T E M _ C O N F IG.r e q u e st 

( M sg  T yp e : 0 x 0 C, C o n fig _ T yp e : 0 x0 0 0 3 )

L O A D _ S Y S T E M _ C O N F IG .r e p ly (0 x 0 C)

C o n fig u r e  h o st/d ia g  p o r ts to  S C I-A

C o n fig u r e  d e vice  m o d e( = n o r m a l m o d e)

/A u to  m o d e ( = 0 )

D e la y  2  s e c o n d s  a f t e r g e t t in g  re p ly

S ta r t n e tw o r k w ith  a  sp e cif ic  P A N ID

S o ft r e se t

L O A D _S Y S T E M _ C O N F IG .r e q u e st 

(M sg  T yp e : 0 x0 C , C o n fig _ T yp e: 0 x 0 0 0 8)

L O A D _ S Y S T E M _ C O N F IG.r e p ly (0 x0 C )

C o n fig u r e  G3  lo n g  a d d r e ss

S E T_ IN F O .r e q u e st 

(M sg  T yp e : 0 x0 4 , IN F O_ T yp e : 0 x0 0 0 2 )

S E T _ IN F O.r e p ly (0 x0 4 )

S E T_ IN F O .r e q u e st 

(M sg  T yp e : 0 x0 4 , IN F O_ T yp e : 0 x0 0 0 3 )

S E T _ IN F O.r e p ly (0 x0 4 )

S e t G 3  P H Y  T X  P a r a m e te r s (o p tio n a l )

S e t G 3  P H Y  R X  P a r a m e te r s (o p tio n a l)

N E T W O R K _ S T A R T.r e q u e st ( 0 x0 8 )

N E T W O R K _ S T A R T.co n fir m  (0 x 0 8)

A T T A C H.in d ica tio n  ( 0 x1 0 )

D A T A _ T R A N S F E R.r e q u e st (0 x 0 0)

D A T A_ T R A N S F E R .co n fir m  (0 x0 0 )

L _ S D U  d a ta  (in c lu d in g  IP v 6  h e a d e r/a d d r e ss)

.

.

.

.

.

.

.

.

.
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Figure 52. G3 Base Node

62 TI G3 Power Line Communication Developer's Kit Design Guide TIDU237–March 2014
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU237


www.ti.com Appendices

6.10 APPENDIX J– File/Message Transfer Packet Example
The zero-configuration GUI provides two simple applications: message transfer and file transfer. These
applications operate in a point to point configuration. The hardware should be set up as described in
Section 1.5.1.These applications communicate with the host message protocol on top of Prime software
stack via UART. The basic packet format used for file/message transfer follows that described in PLC
Suite Host Message Protocol Specification. Here, some packet examples are provided.

Message Transfer

Table 13. Example 1: Data Transfer Request ("Hi") (1) (2) (3)

Header (Host Message Protocol)
Octet 0 1 2 3 4 5 6 7
Data (in hex) 0 81 20 0 8C 0A B6 E2
Description Message ORG=1 Length(LSB) Length(MSB) Header Header Payload Payload

Type CRC16 CRC16 CRC16 CRC16RPY=0(Data (LSB) (MSB) (LSB) (MSB)
REV=0Transfer)
SEQ=1

(1) Gray Shade: Application Protocol Data Unit, which is part of the message control protocol payload.
(2) Length=Header CRC(2B)+Payload CRC(2B)+NSDU_Handle(1B)+QoS/Priority/D-route(1B)+Data Payload(26B)=32B
(3) status 0x00000000: success

Octet 8 9 10 11 12 13 14 15
Data (in hex) 0 0 AA AA 0 0 0 0
Description NSDU QoS/Priority/ Type (Message Transfer Subtype (Transfer) Status

Handle D-route App)

Payload (Host Message Protocol)
Octet 16 17 18 19 20 21 22 23
Data (in hex) 00 00 01 00 00 00 01 00

Status Message Id (=1) (LSB) Page number

Payload (Host Message Protocol)
Octet 24 25 26 27 28 29 30 31
Data (in hex) 00 00 01 00 00 00 02 00

Page number (MSB) (LSB) Total # of pages (MSB) (LSB) Message size (=2B)

Payload (Host Message Protocol)
Octet 32 33 34 35
Data (in hex) 00 00 48 49

Message size (MSB) "H" "I"
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File Transfer

Table 14. Example 1: File Transfer (the first packet) (1) (2) (3) (4)

Header (Host Message Protocol)
Octet 0 1 2 3 4 5 6 7
Data (in hex) 0 81 2D 0 D0 7C 47 54
Description Message ORG=1 Length(LSB) Length(MSB Header Header Payload Payload

Type ) CRC16 CRC16 CRC16 CRC16RPY=0(Data (LSB) (MSB) (LSB) (MSB)
REV=0Transfer)
SEQ=1

(1) Length=Header CRC(2B)+Payload CRC(2B)+NSDU_Handle(1B)+QoS/Priority/D-route(1B)+Data Payload(39B)=45B
(2) status 0x00000000: success
(3) page number 0x00000000: the first page
(4) Gray Shade: Application Protocol Data Unit, which is part of message control protocol payload.

Payload (Host Message Protocol)
Octet 8 9 10 11 12 13 14 15
Data (in hex) 01 00 BB BB 00 00 00 00
Description NSDU QoS/Priority/ Type (File Transfer App) Subtype (Transfer) Status

D-Route

Payload (Host Message Protocol)
Octet 16 17 18 19 20 21 22 23
Data (in hex) 00 00 01 00 00 00 00 00
Description Status Message Id (=1) (LSB) Page Number

Payload (Host Message Protocol)
Octet 24 25 26 27 28 29 30 31
Data (in hex) 00 00 13 00 00 00 77 12
Description Page number (MSB) (LSB) Total # of pages (MSB) (LSB) Message size

(=4.7KB)

Payload (Host Message Protocol)
Octet 32 33 34 35 36 37 38 39
Data (in hex) 00 00 43 3A 5C 67 33 5F
Description Message size (MSB) File message

Payload (Host Message Protocol)
Octet 40 41 42 43 44 45 46 47
Data (in hex) 73 65 74 75 70 2E 6C 6F
Description File message

Payload (Host Message Protocol)
Octet 48
Data (in hex) 67
Description
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Table 15. Example 2: File Transfer (the last packet) (1) (2) (3) (4)

Header (Host Message Protocol)
Octet 0 1 2 3 4 5 6 7
Data (in 0 81 2D 0 D0 7C 47 54
hex)
Description Message ORG=1 Length(LSB) Length(MSB) Header Header Payload Payload

Type CRC16 CRC16 CRC16 CRC16RPY=0(Data (LSB) (MSB) (LSB) (MSB)
REV=0Transfer)
SEQ=1

(1) Length=Header CRC(2B)+Payload CRC(2B)+NSDU_Handle(1B)+QoS/Priority/D-route(1B)+Data Payload(39B)=45B
(2) status 0x00000000: success
(3) page number 0x00000000: the first page
(4) Gray Shade: Application Protocol Data Unit, which is part of message control protocol payload.

Payload (Host Message Protocol)
Octet 8 9 10 11 12 13 14 15
Data (in hex) 01 00 BB BB 00 00 00 00
Description NSDU QoS/Priority/ Type (File Transfer App) Subtype (Transfer) Status

D-Route

Payload (Host Message Protocol)
Octet 16 17 18 19 20 21 22 23
Data (in hex) 00 00 01 00 00 00 00 00
Description Status Message Id (=1) (LSB) Page Number

Payload (Host Message Protocol)
Octet 24 25 26 27 28 29 30 31
Data (in hex) 00 00 13 00 00 00 77 12
Description Page number (MSB) (LSB) Total # of pages (MSB) (LSB) Message size

(=4.7KB)

Payload (Host Message Protocol)
Octet 32 33 34 35 36 37 38 39
Data (in hex) 00 00 43 3A 5C 67 33 5F
Description Message size (MSB) File message

Payload (Host Message Protocol)
Octet 40 41 42 43 44 45 46 47
Data (in hex) 73 65 74 75 70 2E 6C 6F
Description File message

Payload (Host Message Protocol)
Octet 48
Data (in hex) 67
Description
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6.11 APPENDIX K – Download PLC Binary to F28069 Using CodeSkin
1. Install Texas Instruments Prime Development Package from USB stick or www.ti.com/plc
2. Download, install and start the latest C2Prog from http://www.codeskin.com.
3. Connect PLC board to host using USB cable.
4. Power up PLC board by applying 15V to the board
5. Program the *.hex (located in c:\Texas Instruments\<PackageName>\SW\bin) as shown in Figure 53.

Select "28069,67,66" in the Target pull-down and "JTAG" in the Options pulldown.

Figure 53. CodeSkin Chip Programmer
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6. Click on the Configure Ports button and set the JTAG port to "XDS100v1"

Figure 54. Port Configuration Window

7. Start flashing the F28069

Figure 55. Flash Status Window

8. Once this is done, close the program and remove the power cycle board
9. You can now use the new firmware with the corresponding Zero-Configuration GUI or PLC host tools

(PQM).
10. Please repeat the following procedure with the second PLC board.
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6.12 APPENDIX L – Download PLC Binary to F28M35x Using CCS
1. Create the Concerto Target Configuration

(a) In CCS, go to View -> Target Configuration
(b) Click the New icon to create a new target configuration
(c) Give a name to your configuration (for example, ConcertoXDS100.ccxml)
(d) Configure the target:

• Connection (scroll down) Texas Instruments XDS100v2 USB Emulator
• Device (check box) F28M35H52C1

(e) Note: If you do not see the F28M35H52C1 checkbox, then it is likely the CCS you have installed
does not have the ARM tools. These are required for Concerto.

(f) Save configuration

Figure 56. Creating Concerto Configuration

2. Go to View -> Target configurations
3. Launch the Target Configuration
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Figure 57. Launch Configuration

4. Connect the F28M35x control card to host using USB cable
5. Flash the f/w (flash_m3.out/g3_plc_f28M35x.out) on Cortex_m3_0 part and C28xx_0 part, respectively.

Figure 58. Flashing the Cortex and C28xx Parts
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6.13 APPENDIX M – Running Zero-Configuration GUI with F28M35x
1. Switch off SW3-2 on the F28M35x control card, which allows you to use zero-configuration GUI via

SCI-A port on the docking board.
2. Change the GUI configuration by setting the DefaultSCIPort to SCI-A in C:\Program Files\Texas

Instruments\PLC Application Suite\PLC_Application_Suite.exe.config.
3. Connect the PLC board to the host via serial cable (SCI-A).
4. If you want to use FCC band, change the J24 (on the docking board) to 5-6.
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ADDITIONAL TERMS AND CONDITIONS, WARNINGS, RESTRICTIONS, AND DISCLAIMERS FOR
EVALUATION MODULES

Texas Instruments Incorporated (TI) markets, sells, and loans all evaluation boards, kits, and/or modules (EVMs) pursuant to, and user
expressly acknowledges, represents, and agrees, and takes sole responsibility and risk with respect to, the following:

1. User agrees and acknowledges that EVMs are intended to be handled and used for feasibility evaluation only in laboratory and/or
development environments. Notwithstanding the foregoing, in certain instances, TI makes certain EVMs available to users that do not
handle and use EVMs solely for feasibility evaluation only in laboratory and/or development environments, but may use EVMs in a
hobbyist environment. All EVMs made available to hobbyist users are FCC certified, as applicable. Hobbyist users acknowledge, agree,
and shall comply with all applicable terms, conditions, warnings, and restrictions in this document and are subject to the disclaimer and
indemnity provisions included in this document.

2. Unless otherwise indicated, EVMs are not finished products and not intended for consumer use. EVMs are intended solely for use by
technically qualified electronics experts who are familiar with the dangers and application risks associated with handling electrical
mechanical components, systems, and subsystems.

3. User agrees that EVMs shall not be used as, or incorporated into, all or any part of a finished product.
4. User agrees and acknowledges that certain EVMs may not be designed or manufactured by TI.
5. User must read the user's guide and all other documentation accompanying EVMs, including without limitation any warning or

restriction notices, prior to handling and/or using EVMs. Such notices contain important safety information related to, for example,
temperatures and voltages. For additional information on TI's environmental and/or safety programs, please visit www.ti.com/esh or
contact TI.

6. User assumes all responsibility, obligation, and any corresponding liability for proper and safe handling and use of EVMs.
7. Should any EVM not meet the specifications indicated in the user’s guide or other documentation accompanying such EVM, the EVM

may be returned to TI within 30 days from the date of delivery for a full refund. THE FOREGOING LIMITED WARRANTY IS THE
EXCLUSIVE WARRANTY MADE BY TI TO USER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR
STATUTORY, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. TI SHALL
NOT BE LIABLE TO USER FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RELATED TO THE
HANDLING OR USE OF ANY EVM.

8. No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or
combination in which EVMs might be or are used. TI currently deals with a variety of customers, and therefore TI’s arrangement with
the user is not exclusive. TI assumes no liability for applications assistance, customer product design, software performance, or
infringement of patents or services with respect to the handling or use of EVMs.

9. User assumes sole responsibility to determine whether EVMs may be subject to any applicable federal, state, or local laws and
regulatory requirements (including but not limited to U.S. Food and Drug Administration regulations, if applicable) related to its handling
and use of EVMs and, if applicable, compliance in all respects with such laws and regulations.

10. User has sole responsibility to ensure the safety of any activities to be conducted by it and its employees, affiliates, contractors or
designees, with respect to handling and using EVMs. Further, user is responsible to ensure that any interfaces (electronic and/or
mechanical) between EVMs and any human body are designed with suitable isolation and means to safely limit accessible leakage
currents to minimize the risk of electrical shock hazard.

11. User shall employ reasonable safeguards to ensure that user’s use of EVMs will not result in any property damage, injury or death,
even if EVMs should fail to perform as described or expected.

12. User shall be solely responsible for proper disposal and recycling of EVMs consistent with all applicable federal, state, and local
requirements.

Certain Instructions. User shall operate EVMs within TI’s recommended specifications and environmental considerations per the user’s
guide, accompanying documentation, and any other applicable requirements. Exceeding the specified ratings (including but not limited to
input and output voltage, current, power, and environmental ranges) for EVMs may cause property damage, personal injury or death. If
there are questions concerning these ratings, user should contact a TI field representative prior to connecting interface electronics including
input power and intended loads. Any loads applied outside of the specified output range may result in unintended and/or inaccurate
operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the applicable EVM user's guide prior
to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During
normal operation, some circuit components may have case temperatures greater than 60°C as long as the input and output are maintained
at a normal ambient operating temperature. These components include but are not limited to linear regulators, switching transistors, pass
transistors, and current sense resistors which can be identified using EVMs’ schematics located in the applicable EVM user's guide. When
placing measurement probes near EVMs during normal operation, please be aware that EVMs may become very warm. As with all
electronic evaluation tools, only qualified personnel knowledgeable in electronic measurement and diagnostics normally found in
development environments should use EVMs.
Agreement to Defend, Indemnify and Hold Harmless. User agrees to defend, indemnify, and hold TI, its directors, officers, employees,
agents, representatives, affiliates, licensors and their representatives harmless from and against any and all claims, damages, losses,
expenses, costs and liabilities (collectively, "Claims") arising out of, or in connection with, any handling and/or use of EVMs. User’s
indemnity shall apply whether Claims arise under law of tort or contract or any other legal theory, and even if EVMs fail to perform as
described or expected.
Safety-Critical or Life-Critical Applications. If user intends to use EVMs in evaluations of safety critical applications (such as life support),
and a failure of a TI product considered for purchase by user for use in user’s product would reasonably be expected to cause severe
personal injury or death such as devices which are classified as FDA Class III or similar classification, then user must specifically notify TI
of such intent and enter into a separate Assurance and Indemnity Agreement.

http://www.ti.com/corp/docs/csr/environment/ESHPolicyandPrinciples.shtml


RADIO FREQUENCY REGULATORY COMPLIANCE INFORMATION FOR EVALUATION MODULES
Texas Instruments Incorporated (TI) evaluation boards, kits, and/or modules (EVMs) and/or accompanying hardware that is marketed, sold,
or loaned to users may or may not be subject to radio frequency regulations in specific countries.
General Statement for EVMs Not Including a Radio
For EVMs not including a radio and not subject to the U.S. Federal Communications Commission (FCC) or Industry Canada (IC)
regulations, TI intends EVMs to be used only for engineering development, demonstration, or evaluation purposes. EVMs are not finished
products typically fit for general consumer use. EVMs may nonetheless generate, use, or radiate radio frequency energy, but have not been
tested for compliance with the limits of computing devices pursuant to part 15 of FCC or the ICES-003 rules. Operation of such EVMs may
cause interference with radio communications, in which case the user at his own expense will be required to take whatever measures may
be required to correct this interference.
General Statement for EVMs including a radio
User Power/Frequency Use Obligations: For EVMs including a radio, the radio included in such EVMs is intended for development and/or
professional use only in legally allocated frequency and power limits. Any use of radio frequencies and/or power availability in such EVMs
and their development application(s) must comply with local laws governing radio spectrum allocation and power limits for such EVMs. It is
the user’s sole responsibility to only operate this radio in legally acceptable frequency space and within legally mandated power limitations.
Any exceptions to this are strictly prohibited and unauthorized by TI unless user has obtained appropriate experimental and/or development
licenses from local regulatory authorities, which is the sole responsibility of the user, including its acceptable authorization.

U.S. Federal Communications Commission Compliance

For EVMs Annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant

Caution
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
Changes or modifications could void the user's authority to operate the equipment.

FCC Interference Statement for Class A EVM devices
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be required to correct the interference at its own expense.

FCC Interference Statement for Class B EVM devices
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Industry Canada Compliance (English)
For EVMs Annotated as IC – INDUSTRY CANADA Compliant:

This Class A or B digital apparatus complies with Canadian ICES-003.
Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the
equipment.

Concerning EVMs Including Radio Transmitters
This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this
device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired
operation of the device.

Concerning EVMs Including Detachable Antennas
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain
approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should
be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.
This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum
permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain
greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.



Canada Industry Canada Compliance (French)

Cet appareil numérique de la classe A ou B est conforme à la norme NMB-003 du Canada

Les changements ou les modifications pas expressément approuvés par la partie responsable de la conformité ont pu vider l’autorité de
l'utilisateur pour actionner l'équipement.

Concernant les EVMs avec appareils radio

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est
autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout
brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain
maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à
l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente
(p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante.

Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel
d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans
cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2014, Texas Instruments Incorporated
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Important Notice for Users of EVMs Considered “Radio Frequency Products” in Japan
EVMs entering Japan are NOT certified by TI as conforming to Technical Regulations of Radio Law of Japan.

If user uses EVMs in Japan, user is required by Radio Law of Japan to follow the instructions below with respect to EVMs:
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and

Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of
Japan,

2. Use EVMs only after user obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to EVMs, or
3. Use of EVMs only after user obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect

to EVMs. Also, do not transfer EVMs, unless user gives the same notice above to the transferee. Please note that if user does not
follow the instructions above, user will be subject to penalties of Radio Law of Japan.

http://www.tij.co.jp

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 本開発キットは技術基準適合証明を受けておりません。 本製品の
ご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。

1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします

上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

日本テキサス・インスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル
http://www.tij.co.jp

Texas Instruments Japan Limited
(address) 24-1, Nishi-Shinjuku 6 chome, Shinjuku-ku, Tokyo, Japan

http://www.tij.co.jp
http://www.tij.co.jp


STANDARD TERMS AND CONDITIONS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, or

documentation (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance with the terms and conditions set forth herein.
Acceptance of the EVM is expressly subject to the following terms and conditions.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms and conditions that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms and conditions do not apply to Software. The warranty, if any, for Software is covered in the applicable Software

License Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for any defects that are caused by neglect, misuse or mistreatment
by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any
way by an entity other than TI. Moreover, TI shall not be liable for any defects that result from User's design, specifications or
instructions for such EVMs. Testing and other quality control techniques are used to the extent TI deems necessary or as
mandated by government requirements. TI does not test all parameters of each EVM.

2.3 If any EVM fails to conform to the warranty set forth above, TI's sole liability shall be at its option to repair or replace such EVM,
or credit User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the
warranty period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to
repair or replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall
be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit
to determine whether to incorporate such items in a finished product and software developers to write software applications for
use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless
all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause
harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is
designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of
an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.
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FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required by Radio Law of
Japan to follow the instructions below with respect to EVMs:
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.
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【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧くださ
い。http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

SPACER
4 EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.
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6. Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY WRITTEN DESIGN MATERIALS PROVIDED WITH THE EVM (AND THE
DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." TI DISCLAIMS ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY
THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS AND
CONDITIONS SHALL BE CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY
OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD
PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY
INVENTION, DISCOVERY OR IMPROVEMENT MADE, CONCEIVED OR ACQUIRED PRIOR TO OR AFTER DELIVERY OF
THE EVM.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS AND CONDITIONS. THIS OBLIGATION
SHALL APPLY WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY
OTHER LEGAL THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS ANDCONDITIONS OR THE USE OF THE EVMS PROVIDED HEREUNDER, REGARDLESS OF WHETHER TI HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED
TO, COST OF REMOVAL OR REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES, RETESTING, OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS,
LOSS OF SAVINGS, LOSS OF USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL
BE BROUGHT AGAINST TI MORE THAN ONE YEAR AFTER THE RELATED CAUSE OF ACTION HAS OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY WARRANTY OR OTHER OBLIGATION
ARISING OUT OF OR IN CONNECTION WITH THESE TERMS AND CONDITIONS, OR ANY USE OF ANY TI EVM
PROVIDED HEREUNDER, EXCEED THE TOTAL AMOUNT PAID TO TI FOR THE PARTICULAR UNITS SOLD UNDER
THESE TERMS AND CONDITIONS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE CLAIMED. THE EXISTENCE
OF MORE THAN ONE CLAIM AGAINST THE PARTICULAR UNITS SOLD TO USER UNDER THESE TERMS AND
CONDITIONS SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2015, Texas Instruments Incorporated
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other
changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest
issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and
complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI’s terms and conditions of sale
supplied at the time of order acknowledgment.
TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms
and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary
to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily
performed.
TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and
applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide
adequate design and operating safeguards.
TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information
published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or
endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the
third party, or a license from TI under the patents or other intellectual property of TI.
Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration
and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered
documentation. Information of third parties may be subject to additional restrictions.
Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service
voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice.
TI is not responsible or liable for any such statements.
Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements
concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support
that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which
anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause
harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use
of any TI components in safety-critical applications.
In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to
help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and
requirements. Nonetheless, such components are subject to these terms.
No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties
have executed a special agreement specifically governing such use.
Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in
military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components
which have not been so designated is solely at the Buyer's risk, and that Buyer is solely responsible for compliance with all legal and
regulatory requirements in connection with such use.
TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of
non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

Products Applications
Audio www.ti.com/audio Automotive and Transportation www.ti.com/automotive
Amplifiers amplifier.ti.com Communications and Telecom www.ti.com/communications
Data Converters dataconverter.ti.com Computers and Peripherals www.ti.com/computers
DLP® Products www.dlp.com Consumer Electronics www.ti.com/consumer-apps
DSP dsp.ti.com Energy and Lighting www.ti.com/energy
Clocks and Timers www.ti.com/clocks Industrial www.ti.com/industrial
Interface interface.ti.com Medical www.ti.com/medical
Logic logic.ti.com Security www.ti.com/security
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